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Downloading Exercise Files 
Exercise files can be downloaded from the Cheryl Price web site as follows: 
 

  

 

1 In your web browser, type: www.cherylprice.co.nz 

2 Press Enter on the keyboard to display the Cheryl Price website. 

3 
Click in the Product Search box and type the number of this unit 
standard, as shown at the right. 

4 Click on     

5 Click on   

6 

Under the Exercise Files heading click on the underlined blue hyperlink, ie     

Book Exercise Files – V7 Word 2007 or 2010  Free Download 
The File Download dialog box will display.   

7 If you have Winzip use the following instructions otherwise move to step 8. 

 a   Click on  .    

 
b   Click on the  of the  button. 

 c  If My Documents folder is not displayed click on Set default unzip folder at the bottom 
of the list.  Ensure My Documents is selected then click on Select Folder. 

 d    Click on the  of the  button and click on the My Documents folder.  The files will 
be unzipped. 

8 Click on and ensure My Documents folder is displayed.  Click on  

9 
Click on Open Folder which will display My Documents folder.  Right click on the zipped 
exercise file and select Extract All. Click on Extract.  A folder will be created containing the 
exercise files.   

US 113 

US 113 
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viii 

Unit Standard 113 Version 7 
 

Title Produce business or organisational information using advanced 
word processing functions 

Level 4 Credits 10 

 

Purpose People credited with this unit standard are able to: apply 
advanced features and functions of word processing to produce 
business information; and apply language and text processing 
skills to produce business information. 

 

Classification Business Administration > Business Information Processing 

 

Available grade Achieved 

 

Entry information 

Recommended skills 
and knowledge 

Unit 112, Produce business or organisational information using 
word processing functions. 

 
Explanatory notes 
 
1 All activities associated with this unit standard must comply with occupational 

health and safety guidelines and recommendations in relation to working 
environment and work practices.  Reference for this unit standard includes 
Guidelines for Using Computers. Occupational Safety and Health Service: 
Department of Labour, available at 
http://www.osh.dol.govt.nz/order/catalogue/computers.shtml. 

 
2 Definition 

Established conventions refer to accepted practices of display and design for 
page layout, font selection and size, use of proportional font, text formatting, use 
of lines, boxes, borders, shading, tables and columns, and margin alignment.  
Conventions used must produce documents that are fit for their intended use 
and meet organisational style requirements. 

 Organisational requirements refer to the management practices used by the 
organisation. 

 
3 Business or organisational information requires the production of six different 

types of complex documents which may include but are not limited to – legal, 
financial and technical documents; formal reports; formal meeting documents; 
promotional brochures; forms for completing electronically and/or manually. 
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ix 

4 Spelling, grammar, vocabulary, and punctuation in the documents must be 
consistent with the nature and purpose of the business or organisational 
information required.  Candidates must be given the opportunity to proofread their 
work prior to submission. 

 
5 Logical structures such as folders must be used to organise and store files 

according to organisational requirements. 
 
Outcomes and evidence requirements 
 
Outcome 1 
 
Apply advanced features and functions of word processing to produce business 
information. 
 
Evidence requirements 
 
1.1 Advanced formatting features are applied to present documents in 

accordance with the output required and organisational style requirements. 
 

Range advanced formatting features include – creation and 
application of styles, table of contents and index, drop-down 
list and inserted field codes (in electronic form), complex 
tables, macros, outline numbering, page and section breaks, 
import/embed data from another software application; 
includes at least two of the following – use of foreign 
characters, mathematical symbols and/or foreign currency 
symbols, calculations and use of formulae, integration of text 
and graphics, assembling documents using hyperlinks. 

 
1.2 Documents are produced incorporating multiple columns and tabulated 

material in accordance with system features and output required. 
 
1.3 Templates are produced and variable data is inserted in accordance with 

the output required. 
 
1.4 Documents are produced using advanced merge options in accordance 

with the output required. 
 

Range conditional merge, multiple merges from same data source, 
linked files, if/then/else statements, random data records, 
linked database; 
evidence of three is required. 

 
1.5 Document summary sheets are used to ensure effective file management in 

accordance with file access and retrieval requirements, and organisational 
requirements. 

 
1.6 File management facilities are used to search, locate, and manipulate word 

processing files, folders and subfolders in accordance with system features 
and organisational requirements. 
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Outcome 2 
 
Apply language and text processing skills to produce business information. 
 
Evidence requirements 
 
2.1 Spelling, grammar, vocabulary, and punctuation are consistent with the 

nature and purpose of the complex documents required. 
 
2.2 Page layout, format and design of complex documents are consistent with 

established conventions, the output required, and meet organisational style 
requirements. 
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Exercise Files used in this book 
(Instructions are at the front of this book for downloading retrievable files from our web site.) 

 
Names of files 
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Fonts and Page Layout 
Multilevel Numbering 
Borders and Shading 
Symbols and Characters 
File Management  

 
 
Learning Outcomes 
 
At the end of this section you should be able to -  
 

 Describe advanced word processing features 

 Understand the use of fonts, planning a document and page layout. 

 Customise the setup in Word 2010 

 Use Document Properties for efficient file management 

 Use bullets, numbering and multilevel numbering 

 Apply borders and shading 

 Insert symbols and characters 

 Locate files and folders stored on your computer 

 Search for files and folders using search features 

 Manage files and folders 

 Use printing options  

Section 
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Introduction 
Advanced word processing skills provide solutions to many of the problems that occur when 
working with longer and more complex documents than a simple letter, memo or report.  It is a 
common occurrence for a word processing operator to create, edit, or otherwise manage 
documents that are several hundred pages in length.  Advanced skills focus on ways to effectively 
manage this type of document, emphasising features and functions that automate tasks, and 
manage large documents effectively.  Some of the advanced word processing skills you will learn 
in this book are described below. 

Styles 
A style is a set of formatting instruct-
ions combined into a meaningful 
name that can be applied easily to 
text. One of the main purposes of 
styles is to create consistency.  For 
example, the same style should be 
applied to all the main headings in a 
document, and all the other levels of 
headings below them should also be 
consistent.  

In this way it is clear which sub-headings belong together under main headings and therefore 
belong to the same subject. 

Styles can also assist with navigating in a long document, because it is possible to “browse” by 
heading, jumping from one to the next, as long as styles have been applied. 

Word contains a large number of built-in styles for use in many different kinds of documents.  
These styles can be modified or new styles can be created. 

Macros 
A macro is a series of Word commands grouped together as a single command.  Its purpose is to 
automate repetitive tasks, saving time and reducing the opportunity for errors.  A macro can be 
assigned to a shortcut key combination or to a button on the Quick Access Toolbar or the ribbon. 

Fields 
Fields are codes that instruct Word to insert text, graphics, page numbers, dates, etc.  Fields 
automate tasks that would otherwise be completed manually and constantly modified as changes 
are made to a document.  An example is the use of fields for page numbering; sequential 
numbering occurs automatically and is retained when pages are added or removed.  A date field 
will automatically update to show the current date every time the document was opened. 

Templates 
Word has a number of templates containing styles and page layout settings for creating different 
kinds of documents.  Many of them contain powerful built-in macros that prompt for information 
or instructions for inserting information in the appropriate place.  Templates are used to save time 
and to ensure that similar documents, such as faxes, letters or memos, are formatted consistently.  
They can be modified to suit specific requirements, or new templates can be created.  A template 
can contain styles, macros and fields.  

Heading 1 
Style 

Heading 2 
Style 

Heading 3 
Style 

Normal Style 
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Sections 
Long documents can be split into sections that contain different formatting or other features.  For 
example, each section could have its own title in a header or footer, or a certain section could be 
displayed in Landscape orientation to better display the information in it, such as a chart or table.   

Advanced Merging and Sorting Data  
Mail merge simplifies repetitive documents and tasks. It can create many documents at once that 
contain identical formatting, layout, text, graphics, etc and where only certain parts of each 
document vary. A common use of mail merge is to combine a main document such as a letter or 
email, with variable information, such as the names and addresses of those to whom the letter will 
be sent.   

 
Advanced merge options such as sorting and the use of fields further automate and refine the mail 
merge process, providing a fast and accurate solution to potentially complex and time consuming 
tasks. 

Graphics 
Graphics can provide significant enhancements to 
a professional document.  It’s possible to add not 
only pictures, but many other images, such as text 
boxes, a variety of shapes, callouts, captions, 
charts, WordArt and watermarks. 
 
 

 
 
 
 
 
 
 
 
 
  
 
 
 
 

 
 

AutoShapes and text boxes 

Heading created using WordArt 

Memo containing watermark (based on the Contemporary 
Memo template) 
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Standard Formats 

Most organisations use a system for formatting of documents which is often referred to as in-house 
organisational style.  This results in standardisation and recognition of documents and creates an 
image/branding for that organisation.  Documents generally include: 

Letterhead 
Memos 
Faxes 
Agenda 
Minutes of Meetings 
Emails 
Report production 
Spreadsheet headings and formatting 
Balance Sheets and accounting documents, eg invoices, statements 
Additional documents relating to the type of business, eg in a legal firm this would include wills, 
deeds etc. 

Many companies produce a Style Manual or Procedures Manual, which 
contains sample documents, formats used and guidelines for using such 
documents.  This can also include punctuation policies, letter endings, 
etc.  These manuals can range from a short simple document to a large 
bound manual. 
 

Templates 
“Templates” are generally set up for documents that are used often, eg a Word fax form, Excel 
Balance Sheet, specific formatting of a PowerPoint presentation etc.  A template in simple terms is 
a read-only file that can be opened on screen with formatting applied.  Styles are usually set up in 
a template for ease of use and to ensure consistent formatting.  Text can also be included in a 
template, eg fax information such as To, From, Date, Subject.   
 

Styles 

A style is a set of formatting instructions combined into a meaningful name that can be applied 
easily to text, eg formatting instructions for a heading that is Arial, 14 pt, left aligned and bold, 
could be assigned as Heading 1.  This can then be applied from the Styles box on the Formatting 
toolbar to all text requiring this formatting. 

Look at the headings on this page - the following styles have been used: 
 

Standard Formats Heading 1 (Arial 18 pt, bold, Hanging Indent 
0.5 cm, 15 pt Spacing After) 

Templates Heading 2 (Arial 15 pt, bold, 12 pt Spacing Before) 

Styles Heading 3 (Arial 12 pt, bold, 9 pt Spacing After) 

Normal Text Normal (Times New Roman 11.5 pt, Justified) 

Templates are usually set up by staff with a high knowledge level of Word.  The templates can 
then be used easily by other staff who may not have such a good knowledge. 
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The following documents show examples of organisational style requirements of formatting for 
our company.  Notice the same company logo, colour scheme, templates, etc are used throughout. 
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Change the Settings using the File tab 

Exercise 1 

1 Start Word 2010 then click on the  tab. 

2 Click on  at the bottom of the menu. 

The Word Options dialog box will display and General will be selected at the top left. 
 

 

The following two options can be changed if desired: 

 Click in the  to turn the Mini Toolbar or Live Preview settings on or off. 

 Click on the  of the ScreenTip style: box to select between the options.  Note that the 
Don’t show feature descriptions in ScreenTips option will show only the name of the 
command in the screen tip, but no other information. 

3 Click on  at the left. 

4 Ensure the following option is checked .  This 
will ensure that additional spacing is not included in bulleted and numbered lists. 

5 Ensure Show measurements in units of: displays .  Scroll through the other 
options and make changes as required. 

6 Click on  to accept the changes to the settings. 
 
Live Preview, Screen Tips and the Mini Toolbar will not be specified in this book.  It is 
optional as to whether you wish to use these features. 

Click to turn 
settings on 
or off 

Note 

Click to select 
Screen Tip options 

Click here to 
change your 
Language settings 
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Customising the Quick Access Toolbar 
The Quick Access Toolbar can be used for your most frequently used commands.  It can be 
customised – commands can be added or removed and the toolbar itself can be positioned either 
above or below the ribbon. 

Quick Access Toolbar List 
 
Exercise 2 

1 Click on the Customize Quick Access Toolbar  to the right 
of the Quick Access Toolbar.  Options that can be added are 
displayed as shown at the right. 

A tick displays to the left of every option that is currently 
displayed on the Toolbar. 

2 Click on New to add it to the Quick Access Toolbar. 

3 Click on the Customize Quick Access Toolbar  again and 
click on Open.   

4 Add the following options to the Toolbar using the same steps. 

Quick Print, Spelling & Grammar  

Additional Quick Access Toolbar Commands 
Some other useful options that are not on the Quick Access Toolbar list can be added using the 
following steps. 
 
Exercise 3 

1 Click on the Customize Quick Access Toolbar   at the right of the Quick Access Toolbar 
and select More Commands… 

The Word Options dialog box will display, with the Quick Access Toolbar option selected.  
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2 Click on the Choose commands from:  and select All Commands.  The commands are 
listed in alphabetical order. 

3 In the list at the left, scroll down until Close/Close All is displayed.  

4 Click on  then click on .   

5 Also add which is Print Preview from Word 2007 (and Word 2003).   

(You can also add Print Preview and Print which is the Word 2010 option if desired.  This 
will be displayed with the same button  but the name will be different.) 

The commands will be added to the Quick Access Toolbar list on the right as shown below. 

 

6 Add other buttons as required, eg AutoText. 

7 Ensure a tick is displayed in the following option at the 
bottom of the dialog box. 

8 Click on . 

The Quick Access Toolbar is now displayed between the ribbon and the ruler as shown 
below. 

 

You can click on the Customize Quick Access Toolbar  and select Show Above the 
Ribbon.  The position that you display the Quick Access Toolbar is entirely up to you.   

It is a more effective option however, to display the Quick Access Toolbar below the ribbon for 
speedy access to the buttons you have added. 

You can add other useful buttons to the Quick Access Toolbar as you progress through this book. 

The ribbon can also be customised by clicking on the File tab, selecting  then 
Customize Ribbon.  Commands can be added/removed in the same way as customising the 
Quick Access Toolbar.  New groups and new tabs can be created. 

 
 

  

Note 
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Fonts and Effects 
Fonts and Typefaces 
A font is a specific typeface of a given size, such as Arial. 

A typeface is a set of characters designed with a distinctive pattern, eg Algerian or Palatino. 

Fonts can be "scaleable" fonts which means that you can specify any size up to a maximum size 
that you desire, or sometimes the font and size will be listed as Times Roman 12 pt. 

Some typefaces are called serif fonts.  Serifs are small embellishments at the end of the line 
strokes of each character (little curly parts).  Typefaces without serifs are called sans serif 
typefaces and these are plainer fonts.  Your printer manual will tell you how to do a font test to see 
the different fonts on your printer. 

Serif font This is Times New Roman 14 pt font 
Sans serif font This is Arial 14 pt font 

Look at the two font examples closely.  You will notice that in particular, the T and the f in the 
serif font are more decorative than the sans serif font. 

Fonts are measured in "points".  There are 72 pts to 2.54 cm (1").  (12 pts = 1 pica, 6 picas = 
2.54 cm.)  Fonts can also be measured as cpi (characters per inch) on dot matrix printers and 
bubble jet printers.  The larger the point size the larger the font, the smaller the cpi size the larger 
the font. 

Be consistent with using fonts and as a general rule do not use more than two different fonts in one 
document for general office work.  Often Times New Roman is used as body text and Arial for 
headings. 
 

Fonts Available in Word 2010 
Windows has a variety of "TrueType" fonts that will print with all printers (shown as  next to 
the font).  Other fonts that have been installed may also be True Type fonts or Adobe fonts. 

 Click on the Font  in the Font group on the Home tab to see the two types of fonts 
displayed.  The actual font style is also shown. 

  

It is preferable to use TrueType fonts if the files will be used on another computer.  TrueType 
fonts will print with all printers whereas installed fonts may be specific to that computer.  They 
will need to be copied to the Windows, Font folder if used on another computer, or embedded in 
the file. 
  

TrueType Font 

Most recently used 
fonts are shown 
above the double line Sa
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The new Standard default font that comes with Word 2010 is Calibri 11pt for normal body text 
and Cambria for headings, eg  

Calibri (Body) This is Calibri 11 pt font 

Cambria (Headings) Cambria 14 pt font 

Other standard fonts can be used and these are the ones shown below which are used most of the 
time, eg 

Times New Roman This is Times New Roman 12 pt font 

Arial This is Arial 12 pt font 
 
Non-standard fonts are fonts which are used for decorative or specific purposes, eg 

Brush Script MT This is BrushScript MT 16 pt font  

Algerian This is Algerian 18 pt font 
Colonna MT This is Colonna MT 16 pt font 
 

Type Size 
Type size should relate to the importance of the message it communicates, eg the major heading in 
your document should be a larger point size than subheadings.  Lack of contrast in headings can 
confuse the reader of the document.  Captions should be in a smaller point size than normal text.  
The following shortcut keys are useful to increase/decrease font sizes on selected text.   

Ctrl ] Increases the font size by one point size 
Ctrl [ Decreases the font size by one point size 
 

Expanded/Condensed Text 
Text can be selected and expanded/condensed by clicking on the Dialog Box Launcher  of the 
Font group, Advanced tab.  Select Expanded or Condensed from Spacing:  then specify the 
measurement in the By: box.  Click on OK.  
 

Effects 
In addition to changing the size of type, Word 2010 has the following effects available which can 
be selected from the Font dialog box or used with shortcut keys.  Some of these effects will be 
printer dependent.  

Strikethrough Double Strikethrough  Superscript Subscript Shadow 

   SMALL CAPS ALL CAPS 

Hidden (text is only displayed when the Show/Hide button ¶ is activated) 
 

White Space 
White space provides contrast and enables the reader to absorb the context of your document. 
Avoid white space between words by using hyphenation, particularly in column work.  In desktop 
publishing work and in newspaper columns it is better to use one space after a full stop than two. 
The use of white space generally improves the appearance of your document. 
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Page Layout 
Headings 
There are several ways of formatting a heading, depending on the emphasis required. 
 

Centred Heading 
 
This is an example of a centred heading.  This type of heading can be used with any style of 
paragraph - block, first line indent, indented or hanging. 

You would not use a block heading at the left margin and then use a centred heading after 
it – a centred heading is usually a priority heading. 

 

Font Sizes 
It is not current practice to underline headings.  Font sizes are used to grade headings in basic 
office work, eg reports, documents, etc. 

Word allows you to grade headings by changing the size of the “font”.  This is a preferable way to 
emphasise text rather than using underlining.  The larger the “point” size, the larger the type. 

Often headings are in a sans serif font, ie a plain font without small embellishments at the end of 
the line strokes of each character (eg Arial) and the main text in a serif font, ie with small 
embellishments at the end of the line strokes of each character (eg Times New Roman, which is an 
easy-to-read font).  For continuous text a serif font is easier to read. 

In most commercial documents the first heading is in the largest font size (eg 18 pt), the second 
heading would be a slightly smaller font size (eg 16 pt) and side headings in a slightly smaller font 
size (eg 14 pt). 

Headings can be emphasised with bold and/or italics but ensure that these enhancements are also 
graded, eg do not bold a heading unless the heading above it is bold also. 

As a general rule, for office type work do not use more than two fonts in one document.  A variety 
of font sizes can be used and the use of excessive capitalisation can be eliminated. 
 

First Heading 
 Second Heading 
 xxxx xxxx xxxx xxxx xxxx xxxx  xxxx xxxx xxxx  xxxx xxxx xxxx  xxxx xxxx xxxx  xxxx 

xxxx xxxx  xxxx xxxx 

 Third Heading 
 xxxx xxxx xxxx xxxx xxxx xxxx  xxxx xxxx xxxx  xxxx xxxx xxxx  xxxx xxxx xxxx  xxxx 

xxxx xxxx  xxxx xxxx 
 
 Fourth Heading 
 xxxx xxxx xxxx xxxx xxxx xxxx  xxxx xxxx xxxx  xxxx xxxx xxxx  xxxx xxxx xxxx  xxxx 

xxxx xxxx  xxxx xxxx 

Note 
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Planning a Document 
It is a good idea to plan a document that will include text and graphics by sketching out on paper 
different layouts and ideas of the appearance you wish your document to have.  Bear in mind the 
following principles of page layout: 

Proportion: Consider the relative importance of each item, ie the 
relationship between type, white space, graphics, 
paper size and orientation. 

Balance: The positioning of elements on a page. 

Harmony: The elements should conform to the paper size, ie 
portrait/landscape. 

Variety: In size, alignment, font, style, but remember that 
overuse can lead to chaos. 

Sequence: The eye should flow easily through the text/graphics 
and from one part of the layout to another. 

Unity: Look at the overall artistic design of the completed work. 

Also consider the following: 

 Whom is this document intended to attract? 
 What is your message? 
 What form is the publication going to take, eg book, brochure, flyer, magazine, etc 
 Is the content and style appropriate for my audience? 
 Am I consistent with my headings and text style? 
 Is there enough contrast and white space to add interest? 
 Does my publication look busy (crammed and not easy to read)? 
 
In advertisements, flyers, etc, you can vary the display. Often text in the largest font size displays 
the main emphasis.  A variety of fonts, font sizes, enhancements, etc, can be used but it takes 
practice to produce attractive documents.  Study newspapers and magazines for good ideas.   
 

Look at the two publications below.  The publication on the left is an example of inferior design 
and the one on the right is attractive and appealing. 
 

  
 
  

Clear Water Hotel
Sandra Street

Auckland

20 - 22 February 1999 

The Real Estate Club
22 Ross Estate Road, Auckland

Phone: 343 3458   Fax: 343 3459

Techniques in 
Real Estate

SEMINAR

20-22 February 2003 

Brisbane 

22 Ross Street, Brisbane  QLD 4000 
Phone: 3236 6877   Fax: 3236 6878 

Clear Water Hotel
Sandra Street

Auckland

20 - 22 February 1999 

The Real Estate Club
22 Ross Estate Road, Auckland

Phone: 343 3458   Fax: 343 3459

SEMINAR

20-22 February 2003 

Brisbane 

22 Ross Street, Brisbane  QLD 4000 
Phone: 3236 6877   Fax: 3236 6878 
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